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WELCOME TO SWEEPERSCORE BY RCP SOFTWARE
First Things First

Before running SweeperScore, you must set the Excel Macro Security to Medium. On the Tools menu in Excel, select Macro, Security, and set the level to Medium. When you first open SweeperScore you will be prompted to Enable the macros. You must enable macros or the application will not function.

You will need Microsoft Excel version 2002 or later and Windows XP or later.

The Pro version is a very powerful, full-featured version of RCP Software’s SweeperScore software. It can handle sweepers for large leagues and provide scoring for some exotic as well as standard sweeper events. It is not intended to be run on an entry level computer. It is recommended you have 1GB or more RAM, and a recent Windows PC to get snappy performance of the Pro version. Less powerful computers may run the software but the performance may be somewhat degraded, depending on the performance characteristics of your computer. You will need Microsoft Word 2002 to read these instructions on screen. 

Due to the complexity of the Pro version of this software, it may take several seconds to open the application, depending on the speed of your computer.

If you purchased this product in a store or bowling center, please fill in and print out the first page of the Purchaser Info worksheet (last labeled worksheet) and mail it to RCP Software, P.O. Box 476, Shingle Springs, CA 95682. This will register your software so you can receive tech support. You must exit that worksheet by clicking on the labeled tab for any other worksheet because the info worksheet is a specially locked worksheet. If you purchased by direct order, you are already registered.
About RCP SweeperScore

RCP SweeperScore is a specialized Excel spreadsheet application created by RCP Software, a company dedicated to creating powerful but easy to use software that can be used effectively by ordinary people, not just computer geeks. RCP SweeperScore is used to quickly score a bowling league sweeper. It was created by a bowler for bowlers and league secretaries. There are various versions in existence or under development, targeted at specific situations, and customized versions can be developed upon request. 

· SweeperScore Pro – Scores men’s, women’s, and mixed league sweepers with up to 200 men and/or 200 women bowlers. Handles up to 60 mixed teams and up to 60 single gender teams (3, 4, or 5 persons), as long as the number of bowlers of one sex does not exceed 200. Handles all mixed doubles combinations between 100 men and 100 women, all doubles combinations for 120 men, all doubles combinations for 120 women, plus 200 men’s singles and 200 women’s singles. Also scores generic doubles (men and women together but treated the same) for all doubles combinations of 250 bowlers composed of 125 men and 125 women. Also scores a special Hi-Low average doubles sweeper event.
· SweeperScore Standard – Scores team event plus M&W singles and mixed doubles.
· SweeperScore Mini – Scores M&W singles and team sweeper events for small/average leagues.  
These instructions apply to all versions of SweeperScore. If you do not have a feature mentioned here in the version you purchased, simply ignore that portion of the instructions. These instructions have an educational portion up front, followed by some quick reference checklists. You may wish to print out the checklists for handy on-site use.
Experience has shown that most people can learn to use this software effectively in about one hour, instructions for specific features being highly similar to those for other features.

HOW TO USE SWEEPERSCORE – INTRODUCTION

The specialized Excel application can remain on the CD-R disk or the purchaser may, at his/her option, make a single copy and place it in his Templates folder or an appropriate sub-folder for easy access. Each time a new sweeper is scored, the user makes a copy of the template by using the New function on Excel’s File menu, giving the newly created workbook file an appropriate identifying name (e.g., 200605 Bags & Balls Sweeper to indicate a sweeper for that league, bowled in May 2006), then placing it in a folder created to hold information concerning the sweeper or perhaps a series of such sweepers.

The raw bowling scores are entered only once in one location (Games & Totals worksheet) in SweeperScore, then quickly sorted in multiple ways to display ranked results for various events such as Teams (3, 4, or 5 person), Mixed Doubles, Generic Doubles, Men’s Singles, Women’s Singles, Men’s Doubles, or Women’s Doubles. Sidepots can also be scored. 
A special Hi-Low Doubles sweeper event, based on pairing the highest average bowler with the lowest average bowler, may also be scored but this requires some extra steps so you should probably practice the process in advance a couple of times or so. 
It is assumed the user already knows generally how to use Microsoft Windows to operate a personal computer and preferably knows how to use Microsoft Excel at least minimally to operate spreadsheet applications. If the user is unfamiliar with Excel, the following brief comments about certain features of Excel and terminology that are utilized extensively in the operation of SweeperScore should suffice. Persons already familiar with Excel and data sorting from Excel’s Data menu have learned to use SweeperScore effectively in less than one hour.
Some reminder notices and titles of important columns are set forth in Big Bold Red Letters on various worksheets so they’re hard to miss. If it’s in red, it’s important. If you ignore a reminder that’s in red, your computed results aren’t going to make sense.
Commands in command sequences are generally highlighted in bold letters in these instructions so you can spot them easily.

Cells with red triangles in the upper right corner hold helpful instructional comments. Pass your mouse over the cell to display the 
comment.

Cells in which you should be entering data have white backgrounds and cells that are computed and which you should not touch have gray backgrounds. Remember, if it’s white, that’s where you write; if it’s gray, stay away! Some computed cells are locked so you can’t change them even if you try.
EXCEL AND COMPUTER FUNCTIONS, CONCEPTS AND TERMINOLOGY YOU NEED TO UNDERSTAND

Most personal computer users probably know these terms and concepts already but just in case here is a quick review.
Template – The master RCP SweeperScore file you are given on the CD-R disk is a template. Each time you start a file for a new sweeper, one of the things you should do soon after opening the template file into your computer’s memory and working on it is to save (File menu, Save As) your work to a convenient location on your hard drive. Save the new file as an Excel file (.xls extension) with a useful descriptive name (e.g., 200606 Reno Sweeper for Guys and Dolls league.xls) in a location that makes sense to you. Create a new file for each sweeper. Once you have saved your work, you will go back to that new file to change or view your data for that particular sweeper. Keep the RCP SweeperScore disk in a safe place. You are permitted to make a single copy of the template and place it in the folder holding Excel templates or in an appropriate sub-folder you create.
Cell – A rectangular box in a worksheet that holds data, with the cell’s location defined by column (e.g., A, D, H) and row (e.g., 1, 5, 25) coordinates. E.g., Cell G3. 
Active Cell – This is the cell with the highlighted border. This is where you are in the worksheet. Move around a worksheet with (1) the cursor arrows or (2) jump to a cell by left clicking with the mouse cursor over the cell or (3) Edit menu, Go To, enter the coordinates and press Enter.

Data Entry – You enter data by making the location you want to enter data the Active Cell. Then enter the data, then press one of the following keys to move away from the cell: Tab, or Enter, or a cursor arrow. That sets the data. You can change it by simply going back to that cell and entering the changed data right over the top of the former data. With the exception of the optional use Lane column on the team scoring worksheets and entering data (Y, N, or x) to indicate if a bowler is to be specially excluded from or specially included in an event, all data is entered on the Games & Totals Sheet 
Worksheets/Workbooks – Each sheet within a displayed file is a worksheet. The titles of the worksheets are on the tabs at the bottom. All the worksheets together comprise a Workbook aka a File. Thus the filename is the workbook name. To move to a different worksheet, click on its tab. Or, you may move up and down through the worksheets with Ctl + Page Up or Page Down. The exception in SweeperScore is that to exit the Purchaser Info worksheet you must click on the tab for another worksheet.
Data Sorting – This is done with commands on the Data menu. Data menu, Sort, then select the field (such as Team #) by which the data is to be sorted first (primary sort) from the first scrollable list and select Ascending (alphabetical, lowest to highest) or Descending (reverse alphabetical, highest to lowest) as desired. Each scrollable list is populated with the titles of the sortable columns in the worksheet. If you wish to also use a second sorting criterion, the first criterion sorting will be followed by the second criterion sorting. Select the second criterion from the second scrollable list. You may also perform any desired tertiary sort. Clicking on the OK button sorts the data in conformity to your sorting requests. The sorting order is primary, secondary, tertiary.
Data sorting in SweeperScore utilizes a Header Row so that radio button option should be selected in the Sort dialog box.

Generally, you should place the active cell in the column you wish to sort or at least in a column in the contiguous group of sortable columns before utilizing data sorting. Excel must detect sortable data or it won’t sort and will display a caution note indicating it does not detect sortable data. Sorting is done by column, by default. Ignore other options such as sorting across a row because you will not need them for SweeperScore. To remove a sort, such as when you wish to only have a primary sort but a secondary sort was used previously, just select the None option at the top of the scrollable list of fields.
Computed Cells/Computed Data – Data is generally entered by the user into non-computed cells which are just blank, except that they may have formatting coding to shape (format) the data you enter. Computed cells have formulas attached to them and automatically display computed results based on data you entered in a non-computing cell or cells. Generally speaking, you never touch these computing cells. Just view the results. You cannot change what is in certain locked cells; you could change what is in the gray cells BUT DON’T DO THAT.  Directly entering data in such cells will destroy the computer coding. If you make such a mistake, immediately move away from the cell you fouled up and Undo the last change.
Copying/Pasting – You copy data from a source cell to a destination cell by making the cell you want to copy data from active, then Ctl + c. The source cell will now have a flashing border. Paste copied data by moving to the desired location, then Ctl + v. Or you can use the commands on the Edit menu for copying and pasting. Press the Escape key to deactivate the copying mechanism after you have copied the data. To copy a displayed value (such as “N” indicating No) to a series of cells, highlight all those destination cells (make first cell in series active, Shift + hold down appropriate cursor arrow until all cells are highlighted), then paste. The special procedure for copying and pasting a link for the Hi-Low event is explained below with the rest of the explanation for scoring that event.
Freezing/Unfreezing Panes (This means keeping column titles in place and thus continuously visible while you scroll vertically or keeping columns at the left in place while you scroll horizontally) – Freezing rows or columns is handy so you can keep the header row (this is the row at the top that has the column titles) or certain columns (such as the column at the left containing names) always visible no matter how far you scroll down or to the right. To freeze the header row in position during vertical scrolling, highlight the row just below it (e.g., Row 2), then Window menu, Freeze Panes. Now when you scroll way down the worksheet, the top rows will slide underneath the header row. The header row will be a frozen pane in the window. You can do the same thing with columns for scrolling way to the right while keeping some columns at the left in place. Worksheets have header rows frozen by default in SweeperScore. To unfreeze panes, Window menu, Unfreeze Panes.
Splitting – You can split the Excel Window into two parts or “panes”, one above the other, which can be scrolled independently. Window menu, Split. When initially engaged, the “split” separator will be placed just below the header row. You can grab the split line with your mouse and drag it up and down to a convenient location. This feature is handy for quickly entering or simultaneously viewing large amounts of data, some located in each of two widely separated parts of a worksheet such as Row 3 and Row 224 on the Games & Totals worksheet. You may find it very helpful to use this function during original entry of names, handicaps, and team numbers, particularly for mixed league sweepers. To remove the split, Window menu, Remove Split. When you remove a split, that also unfreezes panes so if you wish to freeze the header row again, do that at that time.
Header Row – This is the row at the top of a worksheet containing the column headers aka column titles. It is usually Row 1. You usually want to keep this row visible at all times so you know what column a piece of data is in. 
F6 Key – Most computer keyboards have a row of Function Keys at the top. The F6 key is toggle key that jumps you back and forth between panes in a window, if you have split the window into panes. It is useful in running SweeperScore. If there is an F Lock (Function Lock) key, that must be engaged before the function keys will function as F5, or F6, etc. instead of performing their alternate function.

Clear Contents – If you want to remove data from a non-computed cell, right click on the cell with your mouse and select Clear Contents. Using other commands to clear a cell may result in deleting formatting or other valuable code you can’t see.
SWEEPERSCORE DATA ENTRY

In General

Cautions
All scores (part of the core data) are entered on the Games & Totals worksheet only. Enter raw scores ONLY IN THE GAME 1, GAME 2, AND GAME 3 COLUMNS. The “results” columns on this worksheet (e.g., Hdcp for Series, Game 2 Hdcp, Scratch Series) and the other worksheets are computed. Leave them alone! If you delete anything in the grayed cells, you cannot simply type it back in. You will have deleted formulas. You must immediately Undo (on the Edit menu or use the Undo command from the Toolbar) any such damage. The only exceptions are the Sex and ID # columns on the Games & Totals Worksheet. You can repair that data directly. Because of this potential damage to formulas, never, ever, touch these columns. To guide you to the correct columns for data entry, following industry standards, the columns where you are not to enter data have been grayed. The columns where you enter data have a white background. Columns with an aquamarine background are computed, locked and not sortable. 
Entering Basic Bowler Data And Raw Scores On Games & Totals Worksheet

When you first open RCP SweeperScore, the data will be sorted in its default position. Bowler ID numbers in the Games & Totals ID # column should be in ascending order. If you have played around with the sorting or done some experimental data entry before starting to seriously enter bowler names and other basic data for your sweeper, be sure to re-sort the sheet by ID # + Ascending before entering any names or other bowler data.

Before the sweeper begins, team names, and names of bowlers and their team numbers and handicaps (and averages if needed) are entered on the Games & Totals worksheet. All changes to spellings of names, corrections to team names, etc. are done here only. The other worksheets simply repeat the core data, as appropriate. When you first enter bowler names, their team numbers, and their handicaps, you may find it very helpful to split the Excel Window into two panes, particularly if you are entering data for a mixed league that is not unified, i.e. where there are separate men’s and women’s events. Window menu, Split. Then drag the split line down to about the middle of the window. Then scroll the lower window down to where the ladies’ names begin such as Row 202 in the Standard and Pro versions. Now you will be able to look at both the men’s and women’s data entry areas at the same time. Enter the bowler names and their corresponding data from your league sheet, going right down the league sheet team by team, name by name, jumping back and forth (using the F6 key in the row of Function keys, as previously described) between the window panes as needed to quickly enter data for both men and women.

Per game handicaps are entered in the Hdcp Per Game column. Total handicaps are computed for a 3-game series. Averages are not necessary unless the Hi-Low sorting feature (described below) is to be used. Team names may be entered in the right side (to the right of the bold column which is a sorting barrier) of the worksheet so they will be displayed on the Team (.e.g, Fives, Fours, Trios) results worksheets along with the team numbers. Be sure to select the correct area that corresponds to the number of people on your teams!
Coding to exclude bowlers from non-team events such as doubles or singles events is entered on the corresponding worksheet. Coding to include bowlers in special events such as pot games or doubles events where all possible pairs are not entered by default is also entered on the corresponding worksheet. By default, no one is entered in a pot game and everyone is entered in special events such as mixed doubles, men’s singles, women’s doubles, etc. Coding for exclusion from and inclusion in special events is explained below.
When it comes time to start entering raw scores during your sweeper, you will find it most helpful to go to the Data menu to Sort the Games & Totals worksheet by Team # + Ascending and then leave it that way until you have finished entering all the raw scores. That aligns the worksheet with what the bowlers will bring to you on their recap sheets. If you enter scores after each game, you will be able to determine the winners and rankings for any event within seconds after the last score is entered and probably before the last bowlers to finish have their street shoes back on. Even if done only after all games have been bowled, scores entry is so easy it can be done very fast.
You will also be able to track who is doing the best in any event while the sweeper is still in progress by sorting the data in seconds and you can do that for any event whether it’s the ladies pot game after the first game or the mixed doubles after the second game. But remember that if you re-sort the core data by bowler ID # + Ascending during the event so that you can check on how people are doing in some individual event, you must resort the core data by Team # + Ascending before continuing with scores entry. This only takes seconds but it is important to do.
Instructions Regarding Specific Items
Entry Of Bowler Names & Their Team Numbers
As described earlier, it is easiest to split the Window to display the men’s and women’s default names, then jump back and forth (F6 on most computers, with F Lock engaged) as you enter the basic identifying data (names, team numbers, handicaps) before the tournament or sweeper commences. However, during the event you will just be entering raw scores, unless of course you need to correct something such as ruling out a bowler who didn’t show. So it’s best not to use a Window split into panes while entering scores. 
Team numbers must be two-digit numbers, e.g., 08. If you enter only a single digit, the application will fix it for you automatically.
All rows reserved for a team must be used, otherwise the computed results will make no sense. E.g., if you have 4-person teams, but one team only has 3 members at present, you must enter a VACANT title as a placeholder to fill the fourth row for that team. Here are some examples of acceptable Vacant bowler titles: “Vacant Man 03” for the single vacancy on team #3. Or “Vacant Man 04A” and “Vacant Man 04B” for two vacancies on the same team. Or you might use “Vacant Man 08” and “Vacant Woman 08” for two vacancies team #8. Each vacant bowler must have a unique name. Vacant bowlers get the appropriate blind score each game and the corresponding handicap so that the team event will be scored correctly. Don’t forget to assign a team number to each vacant bowler so sorting by team numbers will work.
Entry Of Team Names

Team names for your 3, 4, or 5-member teams may be entered in the right side (to the right of the bold column which is a sorting barrier) of the Games & Totals worksheet so they will be displayed on the Team (.e.g, Fives, Fours, Trios) results worksheets along with the team numbers. Be sure to select the correct area that corresponds to the number of people on your teams!

How To Handle Vacancies

If you have vacancies on any teams, and you are scoring individual events such as Mixed Doubles or Men’s and Women’s singles or doubles, you obviously must exclude the vacant team members from those individual events. Do that at the same time you set up those worksheets for the sweeper. See the explanations below for how to do exclusions.
The Games & Totals worksheet must have at least a placeholder for each position in the league if you are scoring a league sweeper. Sweeper teams must all have the same number of positions whether that is 3, 4, or 5 positions. If you do not have placeholders or names for each position in the league, the scored results will make no sense. A “position” is, for example, the third person on team #5, even if that position is vacant. Thus, if team #14 was never there, or they quit during the season, and you have 4-person teams, you must have four placeholder rows assigned to team #14. The bowlers could be titled “Vacant Man 14A”, “Vacant Man 14B”, “Vacant Woman 14A”, and “Vacant Woman 14B” or some equivalent titles but these four bowlers must exist in the core data. It is highly advisable to use the following standard syntaxes:
· Vacant Man 01A

· Vacant Woman 01A

· Vacant Bowler 01A

The last syntax above is used for unified sweepers. By using standard syntaxes, all vacants will sort in sequence on other sheets making it easy to locate them quickly.

How To Handle Teams With Extra Members

For teams with extra members, such as 5 people on a team in a 4 person team league, where one or the other is working each week and they take turns bowling, you can enter extra people with the same team number on the Games and Totals worksheet but those who are currently “extras” must have their team number coded for exclusion from team event calculations. Example, code the team number for an “extra” on team #4 as z04. If the extra bowls the sweeper instead of the regular, the regular’s team coding is changed to z04 to exclude him/her and the extra’s team number coding is changed to 04 to include him/her. The excluded person’s name is automatically sorted to the bottom of the list of bowlers and not included in team events. If you have, for example, a league with 3 people per team, only 3 people can have inclusion team number coding for each team at the time of the sweeper.
Excluding Bowlers From Individual Events
In General

You may wish to exclude certain bowlers from prize money contention in certain individual events in a sweeper because they didn’t pay for that event or because they are absent. RCP SweeperScore permits various kinds of exclusions and inclusions in any individual events that are to be scored. Ordinarily, most exclusions will be done in advance but if someone simply doesn’t show for the sweeper (e.g., Joe had a scheduling conflict or passed out in the casino bar), you can always exclude that person from individual events at the last minute and even while the sweeper is in progress. That person’s average (or average minus 10 as league rules dictate) would be entered in the raw scores so that regular team events will score correctly in a sweeper.
Mixed Doubles is considered an individual event consisting of two individuals who are not necessarily from the same numbered team in your league. The same is true for men’s or women’s doubles.

If you are not scoring a particular event, such as Men’s Singles, there is no need to exclude anyone from that event. Just ignore that worksheet.
Note carefully that vacant team members such as “Vacant Woman 06B” must be excluded from any individual events that are to be scored. These exclusions should be done in advance.
There are some reminder flags and titles of important columns in Big Bold Red Letters so they’re hard to miss. Don’t ignore these reminders when doing exclusions or inclusions.
Before attempting to exclude anyone from any non-team event, you must first sort the Games & Totals worksheet by ID # + Ascending.

Excluding Person From A Singles Event 
To exclude a man from the Men’s Singles, first Sort the Games & Totals worksheet by ID # + Ascending. Then go to the Men’s Singles worksheet. Note the column titled “To Be Counted In Men’s Singles?” Everyone is in by default. To take someone out, change the Y to N on that bowler’s row. Now, when the results are sorted (as described below), the N coded persons will drop to the bottom and thus be excluded. 
Remember to always exclude all vacant bowlers who were used in the team event.

Excluding Person From Mixed Doubles

To exclude someone from Mixed Doubles, Men’s Doubles, or Women’s Doubles requires a few more steps because a bowler’s name can appear on dozens of rows, depending on the size of the league, and all combinations that include that bowler must be taken out of the running. As with any other individual event, you must first Sort the Games & Totals worksheet by ID # + Ascending. 
Then, to exclude someone from Mixed Doubles go to the Mixed Doubles worksheet. To exclude a man, Sort by Man + Ascending. Change the Y to N on the first row for that man. Copy the N and paste it to all rows for that man. Press any cursor arrow to clear. Press Escape to disengage the copy mechanism. To exclude a woman, do the Sort on that worksheet by Woman + Ascending, then do the exclusion as explained above.
Remember to always exclude all vacant bowlers who were used in the team event.

Excluding Person From Men’s Or Women’s Doubles

To exclude someone from regular men’s or women’s doubles also has extra steps because you must exclude the person in respect to all entries in both columns. Each person’s name, except the very first name appearing in the Man/Woman A column when the data is sorted by Pair or by Man/Woman A, will appear at least once in each column. To exclude a woman on the Women’s Doubles worksheet, Sort first by Woman A + Ascending, and exclude all instances (rows with her name in column Woman A) by changing the Y to N. Then Sort by Woman B + Ascending, and similarly exclude all the Woman B instances of the bowler’s name.
Remember to always exclude all vacant bowlers who were used in the team event.

Excluding Person From Generic Doubles


Do this the same way as excluding a person from men’s or women’s doubles. (See explanation above.) In this event, men and women in your mixed league sweeper are treated exactly the same. They’re just bowlers, not men or women bowlers. Remember that since all bowlers are being treated the same, their names will show up in both columns, except of course the very first name that appears in the Bowler A column when the data is sorted by Pair #.
Including Bowlers In Individual Events

Including Bowlers In Pot Games

Pot games are a special inclusion. By default, individuals are not entered into pot games. To include, for example, a woman in the ladies’ pot game, first, as usual, be sure the Games & Totals worksheet has been sorted by ID # + Ascending, because this is an individual event. 
Then go to the Women’s Singles worksheet and place an “x” in the Pot Game column for each of the ladies who elect (i.e. fork over the cash) to get in the pot game. Do this all at one time, if possible, for convenience. 

When this singles worksheet is sorted, as described below for pot games, the names of the bowlers in the pot game will rise to the top and then sorting will be done among those names by score.
Including Bowlers In Doubles or Singles Events; Changing Defaults
In the Sweeper editions of scoring software, bowlers are all included in all applicable doubles events, with all bowlers paired with all other bowlers, by default, since these editions will most likely be used for standard league sweepers and most leagues do it that way or would like to if they had the software to handle it. Bowlers are also entered in their singles events by default, in all editions of RCP Software bowling score software. In the tournament editions of bowling scoring software, it is assumed the vast majority of bowlers will pair up with only one or a few other bowlers for doubles and all will enter the singles event. Thus the defaults are set in accordance with the above common practices. If an event is not to be scored in your sweeper, just ignore the worksheet pertaining to it.
However, a league may wish to set up their doubles sweeper events to score and rank only those people who elect to get in the doubles events and who pick specific partners and pay a specific amount for each pair’s entry. The same may be true for singles. Either approach can be accommodated. 
If only a few people do not wish to participate in a particular event, it’s easiest to set the default to Yes (Y) for each row on that worksheet, then change that to N as appropriate. If the vast majority of doubles combinations or singles are going to be excluded, it’s best to change the default to No (N), then change that to Y as appropriate. Use the latter “opt-in” approach when only specifically paid pairs are entered into doubles events.
To quickly change a whole column from Y to N or vice versa: 

1) Go to the top of the column 

2) Change the first entry 

3) Copy changed cell (Ctl + c)

4) Move down to the second cell

5) While holding down the Shift and Control keys, hit the down cursor arrow

6) Paste

7) Hit up or down cursor arrow

8) Escape key
DETERMINING RESULTS


To determine results for various events, there is a two-step process. 
Step One is to sort the core data (on the Games & Totals worksheet) so that it relates to the type of event for which you want to determine results. There are two types of events: (1) Team events, and (2) Individual (non-team) events. All types of doubles and singles are individual events. They are simply various combinations of individuals. Before you can score any individual event you must pre-sort the core data by individuals. That means you go to the Games & Totals Worksheet and on the Data menu you Sort by ID # + Ascending. Before you can determine who won the team event you must first sort the core data by teams. That means on the Games & Totals Worksheet on the Data menu you Sort by Team # + Ascending.
Step Two is to sort the actual event and you do that on the worksheet for that event, as explained below. 

After you have sorted an event, be sure that you are viewing the top rows of the sorted data. The row numbers at the left should show rows 1, 2, 3, etc. down the sheet. If the row numbers reading downward show something like 1, 2689, 2690, etc. you are not at the top. To get to the top hold down the Ctl key and hit Home.
DETERMINING TEAM RESULTS

First things first. As explained above, you must first Sort the entered core data on the Games & Totals worksheet by Team # + Ascending.

Next, go to the worksheet for the size of your teams. E.g, go to the Fours worksheet if you have 4 people per team. 

Assuming you are interested in the rankings by team handicap totals, go to the Data menu and Sort by Team Hdcp Total + Descending. First place team is at the top. Rankings are in bold numbers to the right. If, for some reason, you also wish to sort the data to determine which team had the highest handicap total for say the second game, you can Sort by Game 2 Hdcp + Descending.
You will also notice that a quick-reference team display is included on the Games and Totals worksheet, to the right of the solid, bolded column. As long as the Games & Totals worksheet is sorted by Team # + Ascending, these numbers will be correct. With this display, you can quickly “eyeball” how various teams are doing by team name and/or number while the tournament or sweeper is still in progress, without having to switch to another worksheet or having to look up a team number.
DETERMINING MIXED DOUBLES RESULTS


Again, first things first. This is an individual event so you must first Sort the entered and computed core data on the Games & Totals worksheet by ID # + Ascending. 

Next, go to the Mixed Doubles worksheet. 

Assuming you are interested in the rankings by handicap totals for the pairs, go to the Data menu and Sort. You will use primary and secondary sorting. Primary sort is by To Be Counted In Mixed Doubles + Descending; secondary sort is by Pair Hdcp Total + Descending. First place team is at the top. Rankings are in bold numbers to the right. 

DETERMINING GENERIC DOUBLES RESULTS


Again, first things first. This is an individual event so you must first Sort the entered and computed core data on the Games & Totals worksheet by ID # + Ascending. 

Next, go to the Generic Doubles worksheet. 

Assuming you are interested in the rankings by handicap totals for the pairs, go to the Data menu and Sort. You will use primary and secondary sorting. Primary sort is by To Be Counted In Generic Doubles + Descending; secondary sort is by Pair Hdcp Total + Descending. First place team is at the top. Rankings are in bold numbers to the right. 

DETERMINING SINGLES RESULTS


Again, first things first. This is an individual event so you must first Sort the data on the Games & Totals worksheet by ID # + Ascending. 

Next, go to the applicable singles worksheet.

As with the Mixed Doubles, use primary and secondary sorting. Primary Sort by “To Be Counted …” + Descending, and secondary sort by whatever field you desire, presumably Hdcp Series Total + Descending.
DETERMINING MEN’S OR WOMEN’S DOUBLES RESULTS


Again, first things first. This is an individual event so you must first Sort the entered data on the Games & Totals worksheet by ID # + Ascending. 

Next, go to the applicable doubles worksheet.

As with the Mixed Doubles, use primary and secondary sorting. Primary Sort by “To Be Counted …” + Descending, and secondary sort by whatever field you desire, presumably “Pair Hdcp Total + Descending”.

DETERMINING POT GAME WINNERS

Again, first things first. This is an individual event so you must first Sort the core data on the Games & Totals worksheet by ID # + Ascending. 

Next, go to the applicable singles worksheet.


This time, your first condition is whether or not people are in the sidepot. Pot Game + Descending is therefore the primary sort. Since pot games are often done by individual games as well as by series, your first secondary sort will be whatever you want to score at the moment such as Game 1 Hdcp + Descending. Then change the secondary sort to determine who won the second game, etc.
DETERMINING HI-LOW DOUBLES WINNERS


This special event was provided for at the request of a special lady who is the league secretary of one of the original leagues using RCP SweeperScore. It is suggested that this only be attempted by fairly proficient computer users who can work absolutely accurately. This is not one of the regular features of RCP SweeperScorebut you may find it and the Hi-Low event to be interesting and fun. Again, this is probably not something that should be attempted by beginning computer users.
In this unique event, the highest average bowler in the league is paired with the lowest average bowler; the second highest average bowler is paired with the second lowest average bowler; etc. In order to set this up, there must be an even number of bowlers participating so if there are an odd number of bowlers who wish to participate, someone must be left out. The first thing to determine is exactly who is going to be scored in this special event and who, if anyone, is going to be left out. Do that first (probably some time during the first game), then press on.
On the Games & Totals worksheet, fill in the averages for participating bowlers if not done earlier when you were initially entering basic bowler information. Leave the Avg column on the Games & Totals worksheet blank for any bowlers who are not participating in this event. That includes a blank in that column for any “odd man out.” Use Clear Contents on your mouse’s right-button shortcut menu if you need to remove any averages that were previously entered.
First things first. The Hi-Low Results worksheet must be “set” to properly receive data from the Games & Totals worksheet. When you receive the software, the Hi-Low Results worksheet is sorted in an “at rest” or default position. You must return it to that position before attempting to use it if you have changed the sorting in any manner on this worksheet, such as during a practice session with the software. If you do not start from the default sort position, the results will make no sense at all. Here is how you set the software in the “at rest” position. You must first sort the Games & Totals worksheet by ID # + Ascending, then sort the Hi-Low Results worksheet by Low Avg ID + Ascending. That will return the Hi-Low Results worksheet to the “at rest” position. Note the order of the operations carefully.

Now you are ready to set up the participating bowlers in an array with increasing averages which you will effectively fold in the middle like folding a piece of paper and matching top to bottom. To do this, Sort the Games & Totals worksheet on the Data menu. Primary sort by Avg + Ascending; secondary sort by ID # + Ascending. Have Excel sort anything that looks like a number as a number if it asks you that question. 
Check again to be sure there are an even number of bowlers participating. If there are, the last participant should be on an odd-numbered row because the list starts on Row 2. The number of participants is that last participant’s row number minus one. Make a mental note of the number of participants. The number of pairs will be half that number. Note that you can’t be sure who is participating until bowling starts and you know for sure who is going to be present and participate. “No shows” have to be left out by blanking out their averages in the Avg column. So don’t start this process until you are absolutely sure who is participating.

You will now do a Copy and Paste Special, Paste Link process involving five columns at a time to pair up all the participating bowlers. 
You will obtain the Hi-Low Results worksheet data for columns F, G, H, I & J from the Games & Totals worksheet, by extracting data for the bowlers with the highest averages, then flip the data over to match it up with the data for the lowest average bowlers, then insert it into the results worksheet.

Let’s look at and try out an example. I strongly suggest you try out this process before you have to do it for an actual sweeper. Once you’ve done it, it’s easy but don’t put yourself under the pressure of trying to figure it out on the spot.
Suppose you have 8 bowlers participating. Then you would have 4 low average bowlers and 4 high average bowlers. We will call the low average bowlers L1, L2, L3, and L4. L1 is lowest. We have high average bowlers H1, H2, H3, and H4. H4 is highest. We want to achieve the following pairings:
L1+H4

L2+H3

L3+H2

L4+H1

Remember that bowlers start on Row 2 on the Games & Totals Worksheet. The low half will therefore be on rows 2-5; the high half  on rows 6-9. So we extract the data for rows 6-9, place it on the Hi-Low Flip worksheet, flip it over, and send it on to the Hi-Low Results worksheet to be paired with data from rows 2-5.
The columns you need data from have been conveniently placed next to each other on the Games & Totals worksheet. For our example, highlight the ID #, Avg, Bowler Name, Scratch Series Total, and Hdcp Series Total columns in rows 6-9. You should have a total of 20 cells highlighted. Copy them. (Ctl+c) 
Switch to the Hi-Low Flip worksheet. Go to cell A2. Hit the following keystrokes:  Alt, e, s, l. Use the right cursor arrow key to clear.

Note that the averages are ranked low to high on the flip sheet. We are going to flip the data over to put the highest average bowler on top. Data menu, Sort, sort by High Avg + Descending, then by High Avg ID + Descending. The data is now flipped.
Highlight all the copied and linked cells. In our example there will be 20 such cells in rows 2 through 5. Copy them. (Ctl + c)
Switch to the Hi-Low Results worksheet. Go to cell F2. Alt, e, s, l. Hit any cursor arrow to clear.

Perfect! Now you’ve got it! The bowlers are now properly paired up.
Now you can Sort the Hi-Low worksheet by Pair Scratch Total + Descending or by Pair Hdcp Total + Descending to determine the scratch or handicap winners, second place, etc. 
QUICK REFERENCE CHECKLISTS
Initial Bowler Data Entry

1) Games & Totals worksheet

2) If mixed bowlers, Window menu, Split, adjust split.
3) Enter names, handicaps, team numbers.

4) Remove split

5) Refreeze Header row.

6) Enter team names

Excluding A Bowler From Individual Events

1) G&T worksheet, Sort menu, ID # + Ascending.

2) Go to event worksheet.

3) Change default if appropriate.

4) Sort as appropriate. 

5) Change Y’s to N’s as appropriate.

6) Do for each column on men’s and women’s doubles worksheets.

7) Exclude vacant bowlers.
Including A Bowler(s) Or Pair(s) In Individual Events

1) G&T worksheet, Sort menu, ID # + Ascending.
2) Go to event worksheet.

3) Change default if appropriate.

4) Sort as appropriate.

5) Locate bowler(s) or doubles pair(s).

6) Change N to Y or mark row with an “x” as appropriate for each bowler or pair you wish to include.

Scores Entry
1) G&T worksheet, Sort menu, Team # + Ascending.
2) Game 1, Game 2, Game 3 columns only.
Determining Results
1) Sort core data appropriately (Data menu, Sort, Team # + Ascending for Teams; Data menu, Sort, ID # + Ascending for other events)
2) Go to worksheet for event to be scored.
3) Data menu, Sort.
4) Specify appropriate primary sort.
5) Specify any appropriate secondary sort.
6) Click on OK.
Determining Results For Hi-Low

1) Set Hi-Low Results worksheet at rest. (Do G&T sheet first)

2) Sort bowlers by Avg, low to high on G&T.

3) Copy and link data for high half to Hi-Low Flip worksheet.
4) Flip the data on Hi-Low Flip worksheet. (Data, Sort by High Avg + Descending, then by High Avg ID + Descending)
5) Copy and link data to Hi-Low Results worksheet.
Tech Support  (530) 677-6344 (Free for 1 year from date of purchase.)
rcpbusiness@sbcglobal.net 

Extended tech support may be purchased for an additional fee.
If you did not purchase this product directly from RCP Software, to receive technical support, first please print out the first page of the Purchaser Info worksheet and mail it to:

RCP Software™
P.O. Box 476

Shingle Springs, CA 95682

Also available or under development (please call to inquire) and to be very reasonably priced:

· Tournament version – Scores large tournaments such as city, county, regional or state tournaments for men’s or women’s bowling associations. Also used for unified tournaments where men and women bowl together without regard to gender. Covers teams, singles, doubles, and all-events. 

· Tournament Mixed version – Scores tournaments with mixed events where the men and women bowlers have separate (men or women only) events, and mixed (men and women together but identified by gender) events.
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